
  

Research Grant Application Instructions ​

 
Thank you for your interest in The Leakey Foundation’s research grants. This 
document guides you through the application process. For further questions, 
contact us at grants@leakeyfoundation.org.    

A formal application is required for research grants. We only accept applications 
through our online application system. When you are ready to apply, please 
choose the link that best describes your academic status and proposal.   
I AM A PHD CANDIDATE, SUBMITTING A NEW APPLICATION »   
I AM A PHD CANDIDATE, RESUBMITTING MY APPLICATION »   
I HAVE A PHD, I’M SUBMITTING A NEW APPLICATION » I  
HAVE A PHD, I’M RESUBMITTING MY APPLICATION »   

Each page of the online application contains specific instructions on how to fill out 
the fields. In addition, supporting materials are required for your application. 
These materials must be submitted as PDF documents. This packet contains 
detailed instructions on how to prepare these documents, including instructions 
on how to format your PDFs for submission.   
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Before You Get Started 
  ​
Confirm Your Eligibility   

●​ Your research must be relevant to human origins and evolution.  
●​ Applications are open to advanced doctoral students or post-PhD 

researchers.  
●​ PhD students must be advanced to candidacy (all but dissertation).  
●​ There are no citizenship requirements. Applications are open to candidates 

from anywhere in the world.  
●​ Applicants must be affiliated with an institution such as a university or 

museum. We do not give directly to individuals.  
●​ Resubmittals are welcome and encouraged.  
●​ If you have received a Leakey Foundation grant in the past, you must 

complete all reporting requirements before receiving a new one. If you are 
uncertain about your eligibility, contact us at grants@leakeyfoundation.org 
before submitting your application.  
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Confirm Deadlines   
In order for your application to be accepted for review, all of the required 
materials must be received on or before the following deadlines:   

●​ Spring cycle deadline:  January 10, 11:59 pm PT  
●​ Fall cycle deadline: July 15, 11:59 pm PT  

 
Confirm who will submit the application   

●​ Principle Investigator Policy: Investigators may submit only one proposal 
as a principle investigator (PI) per granting cycle. This policy does not apply 
to co-investigators. For example, you may be the PI on one proposal as well 
as a co-investigator on another.  

●​ PhD Candidates: If the primary work of the project will be performed by a 
graduate student, the project should be submitted under the graduate 
student’s name and will be subject to funding limitations for PhD 
Candidates. ● ​ Former Leakey Foundation Grantees: You must 
submit the required financial accounting statement and final report on your 
previous research project prior to receiving a new award. This directive is in 
compliance with IRS regulations and your signed agreement.  
 

Language Requirement: Application forms must be in English. For any letters of 
permission or other attachments written in another language, English translations 
must be provided.   

Essential application materials 
This packet contains the following:   

●​ Research grant application instructions  
●​ Budget template  
●​ Budget example  
●​ Budget justification example  
●​ Application checklist  

Access the FAQ   
●​ You can find a list of Research Grant FAQs here.  
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●​ If at any point you get stuck in the application process, use this FAQ as a 
starting point.  

Online Application Instructions   

Step 1) Access the research grant application   
If this is your first application, you will be required to create an account first. Start 
your application by clicking the link that best describes you.   
I AM A PHD CANDIDATE, SUBMITTING A NEW APPLICATION »   
I AM A PHD CANDIDATE, RESUBMITTING MY APPLICATION »   
I HAVE A PHD, I’M SUBMITTING A NEW APPLICATION »   
I HAVE A PHD, I’M RESUBMITTING MY APPLICATION »   

Completing your online application   
You will need to enter all the information below.   

Primary Contact   
●​ Enter all contact details  

Application Title and Abstract   
●​ Proposal title and informal proposal title  
●​ List keywords related to your research project  
●​ Provide an abstract (max 275 words) for an audience of peer reviewers, 

including:  
○ Research objectives  
○ Questions to be answered  
○ Relevance of your research to the study of human origins  
○ Basic methodology  
○ Specific study population, materials, and/or area  

●​ A three-sentence research brief describing:  
○ Objectives  
○ The specific study site and methods used  
○ The relevance of your research to the study of human origins  
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Countries of Research and Citizenship   
●​ Country of Research  
●​ Field Site, Lab, or Museum Name  
●​ Country of Citizenship  

Project Financial Data   
●​ Project Budget  
●​ Request Amount  

 
Academic Advisor and Letter of Support   

●​ Enter your academic advisor's contact information.  

●​ PhD candidate only: Contact your academic advisor and request that they 
send a letter of support to grants@leakeyfoundation.org prior to the 
deadline.  

●​ NOTE: The Letter of support should be sent directly from the advisor to 
grants@leakeyfoundation.org. Reference letters included with the 
application will not be accepted.   

Co-Investigators   
List any other major participants in your project. These fields may be left blank if 
there are no other participants. In the attachments section, please include a CV 
for each of the participants listed here.   

Reviewer Suggestions   
Applicants are invited to suggest names of individuals who are especially qualified 
to evaluate their proposal and its methodology. When submitting your 
application, please provide at least three reviewer suggestions for your proposal.    

As part of our funding decision process, The Leakey Foundation will assign 
multiple peer reviewers to review your project proposal in addition to members of 
the foundation’s Scientific Executive Committee. Suggested reviewers do not need 
to be personally known by the applicant.    
Do not suggest:    

●​ A member of your graduate committee  
●​ A participant in your project  
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●​ A member of The Leakey Foundation's Scientific Executive Committee.  

Research Schedule   
●​ Enter information about the schedule and timeline for your proposed 

project  

Financial Responsibility   
●​ Enter information about your institution’s financial contact.  
●​ IMPORTANT: Please ensure that this information is current and accurate. If 

needed, double-check with your institution. Failure to do so can result in 
delays in transferring funds.  

Step 2) Upload attachments   
Format requirements for all attachments:   

●​ Use 12-point black font  
●​ Use US Letter page size (8.5” x 11”) with ½” margins  
●​ Save all files as PDFs  

Your documents must adhere to these guidelines. If your documents are not 
formatted correctly, your application will not be accepted for review.   

Proposal Body   

Your proposal must include the following elements in this order. The body of 
your proposal can not exceed seven (7) pages of single-spaced text:   

1.​ A concise statement of your research objectives or the specific questions to 
be answered.  

2.​ Description of the importance of the research project to your specific field 
and to the study of human origins. What is the relationship of your research 
to The Leakey Foundation’s mission to increase scientific knowledge of 
human origins, evolution, behavior, and survival?  

3.​ Brief history of attempts to answer the same or related questions by other 
researchers.  
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4.​ Detailed explanation of the information needed to answer your research 
question(s) and your methods (how you plan to gather and analyze this 
information).  

5.​ Profile of your past experience using any specialized skills or analysis 
techniques required by your methodology.  

6.​ Statement outlining any preliminary or pilot research you have conducted 
that is directly related to the project and a detailed account of the results.  

7.​ Summary of any broader implications and your future goals relevant to the 
proposed research.  

8.​ Brief description of your schedule for data collection, analysis, and 
reporting.  

9.​ Data Sharing Plan:  
○ Up to one-page data management plan describing how the proposal 

will conform to the Leakey Foundation’s data sharing policy. Please 
include the following:   

1.​ Types of data, samples, physical collections, software, 
curriculum materials, and other materials stemming from the 
project  

2.​ The standards to be used for data and metadata format and 
content, or note lack of standards and possible remedies  

3.​ Policies for access and sharing, including provisions for 
appropriate protection of privacy, confidentiality, security, 
intellectual property, or other rights or requirements  

4.​ Policies and provisions for re-use, re-distribution, and the 
production of derivatives  

5.​ Plans for archiving data, samples, and other research products, 
and for preservation of access to them  

○ A valid data management plan may only include the statement that no 
detailed plan is needed as long as the statement is accompanied by a 
clear justification.   

○ The data management plan will be reviewed as an integral part of the 
proposal, considered under intellectual merit or broader impacts or 
both, as appropriate for the scientific community of relevance.   

June 2025​ ​ ​ ​ ​ ​ ​ ​ ​ ​       ​        7   



Figures, Tables, and Appendix   
●​ Please upload any additional figures and/or tables using the "Figures and 

Tables" option in the drop-down selector of our online application form.  
●​ If an appendix is required, please upload it as a "supplemental attachment."  

●​ Your figures, tables, and appendix should not exceed two (2) pages 
combined.  

●​ Figures and tables should only be included if they are essential to your 
proposal. (i.e., if they clarify methods, the specific sample being studied, or 
the results of previous pilot projects with more efficiency than would be 
possible in the text of your proposal.)  

●​ Figures, tables, and appendix should be aimed at experts in your field and 
clarify the methods or the specific study sample described in your research 
proposal text in more detail. This additional information might include a 
specific list of data to be collected, measurements to be taken, or museum 
specimens to be studied (their location, completeness, etc.).   

●​ If the research project includes a genetics component, but someone other 
than the applicant will be doing the genetics work, please include an 
appendix from the actual person who will be gathering the genetic data or 
doing the genetic analysis.   

Bibliography / Works Cited   
●​ The works cited section should not exceed two (2) pages.   
●​ You may abbreviate and use a font smaller than 12 pt. for your bibliography.   
●​ Do not attempt a complete historical literature review.   
●​ Cite only the most significant references relevant to your research.   
●​ References should list authors, date of publication, the title of the work, and 

where the work is to be found (i.e., journal, book, etc.).    
●​ References should be listed in APA style. See examples here:    

https://owl.english.purdue.edu/owl/resource/560/05/.   
   

Detailed Budget   
Budget Guidelines   

●​ Use the budget template in the Application Materials Packet.   
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●​ Itemize the total budget for your proposed research, including costs for 
items requested/secured from other sources. No overhead is allowed.   

●​ Please use only the suggested major categories included in the budget 
template unless absolutely necessary. Major categories include:   

○ Living expenses (food and lodging, per diem)   
○ Expendable supplies   
○ Travel (airfare, local or ground transportation)   
○ Fees and other expenses (park or museum fees)   
○ Personnel costs (justify in project description)   
○ Special analysis costs (C14, SEM, pollen analysis, etc.) 
○ Equipment *   

●​ Important: If the total budget for your project exceeds the amount you are 
requesting from The Leakey Foundation, your Itemized budget sheet must 
include a breakdown of how all funds, including those from other sources, 
will be used.   

●​ Make sure that the line item column is wide enough so all text is visible.   
●​ All budget PDFs must be exactly one page: The blue lines (and dashed 

blue lines) will adjust the items that print to one page. Please adjust these 
within Excel so your budget fits on one page and is still legible. This is 
particularly important if you’ve added funding sources.   

●​ Save your file as a PDF before uploading it to your application.   
●​ An example of a budget created with the required template is included in 

the Application Materials Packet.    

* Note on Equipment Requests: The purchase of expensive permanent equipment 
such as computers, cameras, video and recording equipment, vehicles, boats, etc.  
is not generally funded by The Leakey Foundation. Applicants are advised to 
request such items from other granting agencies. Equipment is occasionally 
awarded under special circumstances. Contact the grants department at 
grants@leakeyfoundation.org for exceptions.    
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Budget Template Instructions   
Please note: The budget template is pre-formatted, including formulas for 
summing line items. To avoid breaking these formulas, take care when adding 
new line items under each suggested heading.    

●​ To add a line item, click the row number on the left side of the window to 
select the row. Then, from the “Insert” menu, select the “Rows” option. This 
will insert a new row while keeping all of the formulas in the spreadsheet 
intact, saving you time on math.   

●​ Please delete unused line items: To delete unused line items and keep the 
formulas intact, click the row number to select the whole row, then go to the 
“Edit” menu and select “Delete.”   

●​ Double-click the cell containing the text “Request from <Funder A>” and 
replace “<Funder A>” with your funding source’s name.   

●​ To add a funding source: Click the column heading button (labeled with a 
letter). This selects the whole column. Go to “Edit” -> “Copy”. Now click the 
column heading button for an empty column to select an empty column. Go 
to “Edit” -> “Insert Cells”. Don’t forget to change the label for your new 
funding source.   

●​ To delete extra funding sources: Click the column heading button (labeled 
with a letter). This selects the whole column. Go to “Edit” -> “Delete”. The 
funding source is now deleted.   

 
Budget Justification   

●​ Your budget justification should justify and clarify your budget items. Please 
use this section to provide any extra detail you think someone reviewing 
your budget may need. Please explain reasons for travel, why you need 
money for assistants or graduate students, how you arrived at flight, living 
expenses, and lodging expense estimates.   

●​ Please include a description/explanation of the other sources of funds for 
your project, including funds for which you have applied.   

●​ This section should not exceed 1 page in length   
●​ There is an example in the Application Materials Packet    
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Permits and Visas   
Provide copies of the permits and visas necessary to conduct your research. 
Please include visas and permits (and permissions) from national parks, 
museums, zoos, laboratories, etc.   

If these documents are not currently available or must be obtained in-country, we 
ask for “reasonable assurance” that the permits and/or visas can be obtained.   
Reasonable assurance may take the form of:   

●​ Documentation from the permit/visa agency that the permits or visas can be 
obtained without trouble. (PREFERRED)   

●​ Copy of a previous year’s permit or visa.   
●​ Statement that you have obtained the permits in the past without trouble   
●​ Statement from a colleague that has previously obtained the permits/visas 

that the permits/visas have been obtained in the past without trouble 
Submitting your permits and visas   

●​ Please scan your permits and visas in color if possible.  
●​ You may upload multiple PDF files including your permits or visas. They 

need not be collated into one document.  

If you have questions regarding permits/visas, please feel free to contact us at 
grants@leakeyfoundation.org.   
 
Investigator CVs   
A CV is required for the Primary Investigator and each of the Co-Investigators 
listed in the application. CVs should not exceed two pages.   

Each CV should include education, relevant experience, awards, and publications.   

General Contingency Plan   
Considering potential impacts to your project plan (for example, COVID-19, 
political unrest, natural disasters, emerging infectious diseases, or unforeseen 
financial challenges), it's essential to have formal contingency plans for your 
proposed project. In up to one page, please describe the possible risks you may 
encounter that could hinder the successful completion of the project and outline 
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your plans for adjusting this project if needed. Considerations for your 
contingency plan should include:  
  
Operational contingencies: Please describe how you would modify key aspects of 
your project if disruptions occur. This may include modified start dates for travel, 
fieldwork, or data collection, alternative data collection strategies, alternative field 
sites, or alternative methods for recruiting and engaging participants, as well as 
any other potential modifications to research and development activities 
(including IRB/IACUC approvals/changes).  
  
Financial contingencies: If your project's Total Budget exceeds the amount you are 
requesting from The Leakey Foundation, your submitted Itemized Budget must 
include a breakdown of how all funds, including those from other sources, will be 
used. Please describe how your project will proceed if you do not receive funding 
from other sources to which you have applied, and justify whether any portion (or 
all) of your project would still be feasible to complete under such circumstances.  
Finally, if The Leakey Foundation is only able to provide partial funding (e.g., 50% 
of your requested amount), please detail what you would be able to accomplish 
with this level of support.   
  
Please include this document as a PDF attachment to your proposal. You may 
upload the PDF as a “Contingency Plan.”  
  
Letter Of Resubmission   
Resubmitted proposals must include a Letter of Resubmission (1-2 PDF pages) 
addressing reviewers' concerns and the changes made.   
Please be sure to address all reviewers’ concerns and your response to them. Note 
that your proposal may be reviewed by some, if not all, of the previous reviewers 
of your original submission(s).    

Supplemental Attachments   
When uploading attachments for your application, you may use “Supplemental 
Attachment” to upload additional documents that you believe are appropriate but 
do not fit into any of the other categories.   

June 2025​ ​ ​ ​ ​ ​ ​ ​ ​ ​       ​        12   



Step 3) Follow up on letter of support (PhD candidates)   
PhD candidate only: After you have completed the application, be sure to 
confirm with your academic advisor that they have sent your letter of support to 
grants@leakeyfoundation.org prior to the deadline. The PhD candidate 
applications will not be complete until a letter of support has been received.    
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Tips for a Successful Application​
   

●​ Use the application checklist found in the Research Grant Application 
Materials zip folder.    

●​ State your hypotheses clearly with ways and means of testing them.   
●​ Carefully proofread the application before submission. If English is not your 

first language, consider having a native English speaker proofread it as well.   
●​ Submit a spare (but realistic) budget. Find out from other researchers what 

they have spent on lodging, food, and transportation in your study area.   
●​ Review and accurately cite related literature thoroughly.   
●​ Provide assurances that necessary permits and visas are obtainable. Provide 

letters of permission for study of museum collections.   
●​ For archaeological research, include sections, fossil lists, lithic lists, latitude 

and longitude coordinates, and an accurate map.   
●​ When feasible, carry out and provide results of a pilot study.   
●​ When creating your budget, make sure all budget items are visible in the 

final PDF.    
●​ If you are a PhD candidate, follow up with your advisor to ensure they have 

submitted your letter of support.    
●​ If you get stuck, reference the Research Grants FAQ.  

  

Grant Review Process 
   
The following is the standard process we follow for selecting grants to fund:   

●​ All grant applications are first reviewed by our Grants Department to ensure 
they are complete and within our purview.   

●​ Proposals are then sent to our network of scientists with pertinent expertise 
for peer review (more details below).   

●​ Next, proposals and peer reviews are evaluated by The Leakey Foundation’s 
Scientific Executive Committee (SEC).   

●​ Our SEC meets and recommendations are made for proposals to be funded.   
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●​ Our SEC then presents recommendations to our Board of Trustees for 
approval.   

●​ Once recommendations are approved, applicants are notified and peer 
review feedback is shared.    

More on the Peer Review Process and Feedback   
Grant proposals are sent to scientists with pertinent expertise for peer review, 
evaluated by the Scientific Executive Committee, and must be approved for 
funding by the Board of Trustees.    

Reviews that we have received will be sent to applicants. These reviews are 
intended to offer constructive criticism. Final decisions are also based on 
consideration of the current applicant pool, the relevancy of your proposal to 
understanding human origins, and the funds available during a given year.   

   
Ethical Behavior and Conduct Policy    
​
The Leakey Foundation does not tolerate sexual or other harassment or 
discrimination by awardees at facilities, field sites, conferences, or workshops 
where Leakey Foundation-funded research is conducted or presented.   

Awardees are expected to comport themselves ethically, honestly, and 
respectfully in furtherance of The Leakey Foundation’s mission. You must fully 
comply with all Leakey Foundation policies (Click here to see our Community 
Standards of Ethical Values and Conduct Policy ). You must also comply with the 
rules, policies, and directives of your institution, the ethical codes of the 
professional organizations and societies to which you belong (e.g. the American 
Association of Physical Anthropologists), and applicable law. You must remain in 
good standing with your institution at all times.    

Research shall be conducted with intellectual integrity, honesty, accuracy, and 
objectivity in compliance with applicable institutional research policies and 
protocols and with appropriate regard for human and animal subjects. Awardees 
shall not fabricate data or results; change or knowingly omit data or results to 
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misrepresent findings in the research record; or intentionally misappropriate the 
ideas, writings, research or findings of others. Awardees are expected to comply 
with specific grant terms and conditions and to avoid conflicts between their 
private interests and The Leakey Foundation’s mission.   

Data Sharing Statement  
 
The Leakey Foundation, like other funding agencies and journals, believes that 
transparency, openness, and accountability are essential parts of the scientific 
process, and we expect results/data of projects funded by The Foundation to be 
published in a timely manner.   

The Leakey Foundation also aims to promote the sharing of data in an appropriate 
manner consistent with the needs of our grantees, but with the recognition that 
different fields of study require different approaches to data sharing. It is required 
that each applicant provide a brief statement (no more than one page) of how 
they intend to make the data resulting from their Leakey Foundation grant 
available to others. This statement should be submitted in PDF format.   

The Leakey Foundation also aims to promote the sharing of data in an appropriate 
manner consistent with the needs of our grantees, but with the recognition that 
different fields of study require different approaches to data sharing. It is required 
that each applicant provide a statement (no more than one page) of how they 
intend to make the data resulting from their Leakey Foundation grant available to 
others. The data sharing statement must include a more detailed plan than an 
intention to publish or present at a conference. Please see the detailed application 
instructions for specific guidelines on the data sharing statement.   
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Urgent Funding Requests  

  
Applications submitted between deadlines that request immediate review 
because of urgent research will be accepted on a very limited basis. Any such 
request must accompany a thorough explanation of the urgency of the research.   

Contact Information 
   
The Leakey Foundation  ​ Telephone: +1(415) 561-4646   
1003B O’Reilly Avenue  ​ FAX: +1(415) 561-4647   
San Francisco, CA 94129-1359    USA  ​ E-mail: grants@leakeyfoundation.org   
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